Lab Windows Server 2008

Lab # 16 — Terminal Services

Terminal Services

I. Giéi thiéu:
- Terminal Service Remote Application la mdt tinh ndng méi trén Windows Server 2008. Cac
chuong trinh tng dung sé dugc cai dat san trén Windows Server 2008, cac may tram tuy khong
cai dat chuong trinh tng dung, nhung van c6 thé khai thac cac chuong trinh ¢ng dung do trén
may chu thong qua Terminal Service.

1.

Pac diem:

- C4c may tram khong can phai c6 cau hinh phan ciing manh va doanh nghiép khong phai ton
nhiéu chi phi vé ban quyén phan mém khi sir dung dich vu nay. Tuy nhién, doanh nghiép van
phai mit chi phi ban quyén cho CAL (Client Access License), va chi phi nay van thap, c6 thé
chap nhan duoc

- May tram két n6i dén méay chu théng qua Terminal Service nén may tram phai dugc cai dat
Remote Desktop Connection (RDC) 6.0 tro 1én. C6 thé download RDC 6.0 cho Windows 2003
SP1 va Windows XP Professional SP2 tai http://support.microsoft.com/default.aspx/kb/925876.

. Céc hinh thire may tram két néi dén may chi:

- C6 4 cach dé may tram két ndi dén may chu khi khai thac chuong trinh tng dung trén may

chu:

» Sir dung trinh duyét web: May chu phai cai dat thém Terminal Service Web Access, may
tram phai duoc cai dat Remote Desktop Connection (RDC) 6.1. RDC6.1 ¢6 san trong
Windows Vista Service Pack 1 va Windows XP Professional Service Pack 3.

= Sir dung Network Access: May chii tao san file .rdp (mdi chuong trinh tng dung twong {ng
1 file .rdp) va dugc share trén may chu, may tram truy cip vao may chi, chay truc tiép file
d6 dé khai thac chwong trinh (g dung trén may chil.

= Sir dung Network Access: Mdy chu tao san file .msi (mdi chuong trinh ing dung twong tng
1 file .msi)va dugc share trén may chu, may tram truy cap vao may chi, chay tryc tiép file
do6 dé cai dat cac shortcut lién két dén chuong trinh (g dung trén may chi. Cac shortcut nay
duoc cai dat trong Start menu cia may tram, cu thé Ia muc Remote Application. May tram
chay céac shortcut d6 dé khai thac chuong trinh ¢ng dung trén may chu.

= Sir dung policy (ap dung cho méi trudng Domain) dé trién khai hang loat viéc cai dat
shortcut lién két dén chuong trinh ing dung trén méay cha cho nhiéu may tram.

I1. Chuan bi: Hé théng gdom:
- Server: Windows Server 2008

+ Tao local user: sv1/123 , sv2/ 123 va add vao group remote desktop users
+ Bat ch¢ d6 remote desktop trén may server.
+ Change password Adminstrator 1a 123

- Client: Windows XP.

I11. Thwc hién:

1.

Cai dat Terminal Services:
- Start->Programs-> Administrative Tools—> Server Manager. Chuét phai Roles=> Add Roles.
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E, Server Manager h ;lgﬂ
File  Action VWiew Help ;1 {,'.u E-' \\1
&= | 2mE| . =
-
=oY o P - N e
2 Add Roles
Remove Roles View the health of the roles installed.an yourserver and add or
remove roles and features,
Wiew L4
r "
Refresh : ALY s
[~ Roles Summary A L J}\f— / Raoles Summary Help
Help ) .:_-_ \
() Roles: 2of 17istall=d Eﬂh Add Roles
33 Remove Roles
(i IFile Services
{i 1 Terminal Services
't L g
'Z_f_i' File Services E File Services Help
Provides technologies that help you manage storage, enable file replication, man
folders, ensure fast file searching, and enable access for UNIX dient computers [
1| | 3
1| 5\-}-"-\-{‘ | _pl £ LastRefresh: 10/23/2009 8:33:44 AM  Configure refresh
|Addyroles 10 tils server. |
PR

H JEE i -l “iﬁenrerﬂarsager |b @[&3 5134 AM

- Before you begin—>Next

Add foles Wizard i B
& Before You Begin =)
Nl
Before You Begin This wizard helps you install roles on this server. Y which roles to install
based on the tasks you want this server to perform, Sgich as sharing documents or
Server Roles hosting a Web site,
Confirmation 9 \\‘
Before you continue, verify that: \\\‘> ¢
Progress r
o The Administrator account has 3'st password
Results » Network settings, suchas.st ddresses, are configured
« The latest security Windows Update are installed

If you have of the preceding steps, cancel the wizard, complete
the steps run the wizard again.

L@@\} Next.

i :\Q\)\ I skip this page by default

= Previols ” Next > I Install Cancel
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- Chon Terminal Services—> Next.
2

Select Server Roles
S\
. \©
Before You Begin Select one or more roles to install on this server. b \Q\L )
Server Roles Roles: Q D cription:
L : : :
Terminal Services ] active Directory Certificate Services | % 2;2;;235
Role Services |:| Active Directory Domain Services users to access Windaws-
Confirmation [[] active Directory Federation Serces based programs that are
[] Active Directory Lightwelght Biréctory Servic installed on aterminal server
Progress [] active Directory Rights\Management Service ;:_t'; acce;s tE-te fm‘:‘ﬁ'th
L Y indows desktop. Wi
Results E ;E'I::IEZ?” "\ Terminal Services, users can
A access a terminal server
[ DMS Server from within your corporate
[] Faw server network or from the
e | L1/Fileservices Internet.
20 | [ Network Policy and Access Services
i
- |:| Print Services b
N\ \{
—\AQS ] ubor Ser'-,t?fs
‘.l\(&\l \ |_|| Wilak Sarate T I hl
) 1 3
N r')

More about server roles

N

O\
O

QU < Previous | Mext = I Install | Cancel

- Hop thoai Instruction to Terminal Services—> Next.
- Chon Terminal Server-> Next.

E

Select Role Services

RLA LT
Before You Begi N \\(Q}'
EILE U EEL Select the role services to install for Terminal Servicess, E
Server Roles Role services: -.'Q f\\ cription:

Terminal Services Terminal Server enables a

" " serverto host Windows-
(] 7 Leerang based programs or el

n Y [] 5 Session Broker Windows desktop.Users can
BT D TS Gateway connect to a terminal server
Authentication Method ] 75 web Access [% to run programs, savefiles,

and use network resources

Licensing Mode on that server.

User Groups

Confirmation

Progress "")
‘, '
Results Q

&) v\ Mare about role services
< Previous | Mext = I Install Cancel
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- Application Compatibility dé mic dinh—=>Next.

Add Roles Wizard N

Uninstall and Reinstall Applications for Compatibility

SANA
: N
Before You Begin Itis recommended that you install Terminal Server be‘%%\&gﬂﬁgtall any
G ver Rlos applications that you want to make available Qu rs.
g : NS
Terminal Services v If youinstall Terminal Server on a co! rthat already has applications

Role Services = installed, some of the existing icatais may not work correctly in a multiple
user environment. Uninsta[li thien reinstaliing the affected applications

Application Compatibility may resolve these is: \‘\'

Authentication Method Some application%q/u/ minor setup modifications to run correctly on a

Licensing Mode terminal 5@
t\,
User Groups
Confirmation (,“/©\
Progress f) z 2
P, )
Results Q

- =) \\ More about installing applications on a terminal server
\\

< Previous ” Nexi\& I Install I Cancel |
- Authentication Method->Chon Do Not Require Network Level Authentication—>Next.

Add Roles Wizard W

Specify Authentication Method for Terminal Server

Oy
Before You Begin Metwork Level Authentication is a new authenticatio at enhances
Server Roles security by providing user authentication earlier in the ‘cannection process when a

client connects to a terminal server, With MNehy evel Authentication, user
Terminal Services authentication occurs before a full R connection to the terminal
server is established. 3
Role Services t )
. . AL A I0
Application Compatibility Specify whether Metworl ﬁ ntication is reguired.
Authentication Method
r Require Ne rkh\j, entication
Licensing Mode Only com| that are running both a version of Windows and a version of
User Groups th top Connection dient that supparts Network Level
jon can connect to this terminal server. If you are remotely
Confirmation { d to this server, ensure that your computer supports Metwork Level
Z tication to enable reconnection to this server.
Progress ~
Results @ ) ¥ Do not require Network Level Authentication
Comp%rs that are running any version of the Remote Desktop Connection
N dient cah connect to this terminal server.
A0S i
-.‘l,\ l "} [ ¥ This option is less secure than when Network Level Authentication is used
,3\\\ b because user authentication occurs later in the connection process.
A \\ - More about Metwork Level Authentication and supported dients
f\\
S Q \
()
(¥

< Previous | Mext = I Install Cancel
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- Licensing Mode—>Configure later->Next.

Add Roles Wizard ] 2
m Specify Licensing Mode \
Before You Begin The Terminal Services licensing mode determines %&)Tem\mal Services
Server Roles client access licenses (TS CALs) thata Ilcense s ill issue to clients that

connect to this terminal server.
Terminal Servi
. Specify the Terminal Services Ilce at you want this terminal server

Role Services to use.

Application Compatibility - Q

Authentication Method S SLone i \

P d Remind us minal Services Configuration tool or Group Policy to

Licensing Mode conﬁgur mode within the next 120 days.

User Groups
Confirmation

r Devnce CAL must be available for each device that connects to this
Progress inal server.
e (_ ) " Per User
A )“\‘ A TS Per User CAL must be available for each user that connects to this
\& terminal server,
A0)
Q\ \) ‘) @ The licensing mode that you spe must match the TS CALs that are available
\ e e € i o8 ot X e M o i
Q 2 < Previous ” Next > I Install | Cancel I
- Add 2 user sv1 va sv2 vao dé co6 thé access the terminal server.
Add Roles Wizard B N = W

ﬁ Select User Groups Allowed Access To This Terminal Server

Ay
Before You Begin O

Add the users or user groups that can connect to thig'te gerver. These users
Server Rolas and user groups will be added to the local Remote De: Users group. The
Administrators group is added by default and t be removed.
Role Services Users or User Groups: ‘\(\\j N
Application Compatibility i Administrators ‘ Add
Ao mstad &, sv2 (WIN-v45B062300K s112)
- B, sv1 (WIN-V45805230QK\sv 1) Remoye |
K
Confirmation
Progress
Results (( )
W
& \ \
] O
More about the Remote De: Users gr:

2

ﬁ-\

< Previous “ Next > I Install Cancel
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- Confirmation Installation—->chon Install. Sau khi cai dat xong thi chon Restart—>OK.
Add Roles Wizard

P W
ﬁ Confirm Installation Selections
A
. ©)™
Before You Begin N
To install the following roles, role services, or feature ﬁ:ﬁ nstall.,
Server Roles . N
) . /1 1warning, 2 informational mes
Terminal Services _ ’s?&es\
Role Services @ This server must be restartetigfter the installation completes.
Application Compatibility () Terminal Services
Authentication Method Terminal Server
Jicensing Mode A0y Yourfay need o reinstall existing applications.
@ IE Enhapced Security Configuration will be turned off.,
User Groups e .
Althertication method: Do not require Network Level
Progress - Licensing mode: Cu:unfl;!ure licensing mode later
k,('\ Groups allowed access: Administrators, sv2
Results = (WIN-V45B062300K \ev), svl
(WIN-V45B06230QK \sv 1)
A
AN

QO

U
R

Print, e-mail, or save this information

| b
< Previous | [ext > | Install I Cancel |

- Kiém tra Remote Connection di duoc enable. BAm phai chudt Computer=Chon properties
—>Remote Setting—> Tab Remote.

:
NS

Computer Name I Hardware I Advanced Herhe I [}&’}
k<4

— Remote Assistance =,
©

-
™| &llow Eemnate Assistance connections to this cnmputag\i\:— )

‘ )
&% © bdvanced .
&
'1\‘*:\"1\
N

Click an option, and then specﬂ@can connect, f needed.
b

— Remote Desldop

" Dont allow cunnectiu[(@q computer
. o 1 :
* Allow connections,froM €omputers running ary version of |
‘Femate Deskfop less securs) :
N

" Allow con ions only from computers unning Remote
Clesht etwaork Level Authertication {more securs)

@u@}m Select Users... |
N
P

@Slor\{ QK I Cancel | Lpply |
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2. Thém cac chwong trinh wng dung RemoteApp:
- Start->Program-> Administrative Tools->Terminal Services>TS RemoteApp Manager.
- Menu Action—->Add RemoteApp Programs.

Lab # 16 — Terminal Services

“;TI’S RemoteApp Manager - |§| X|
| File | Action View Help / '\\\\\
2
@ = Connect to Computer (‘ ,‘-\Q’)‘ .
~\
TS Add RemoteApp Programs | | Actions
Terminal Server Settings programs that are accessed through Terminal Services, and appear as if they :\( .5?5 RemoteAp... «
( TS Gateway Settings local computer. Before yo_u can make a RemoteApp program available to )) 1 .ﬂ Connectt...
R?— Digital Signature Settings he RemoteApp Programs list. +
[ AddRemo...
Export RemoteApp Settings
Ovl Import RemoteApp Settings - & Terminals...
o
— NS 8 715 Gatew...
Termmar SeTveT SETOnys Criang Distribution with TS Web Access B Digital Sig. ..
A The TS Web Access Computers group is empty.
cents wi S WIN- -
(@) Clients will connect to: WIN-V45B06230QK Remotelpp programs may be unavailable to = ExportRe...
/" Users can only start listed Remotelpp programs users, Refresh|-Learn more e
L . - _ ig Import Re...
on initial connection. (Recommended) & The Remotedpp Programs list is empty
X \ < list is Y.
i = . . . View 3
TS Gateway Settings Change (i) Aremote desktop connection for this serveris s
@ Clients will use T5 Gateway settings defined by | not visible in TS Web Access, Change Help
their domain's Group Policy. i
Digital Signature Settings Change | "@ Meore about using TS Web Access
A N.o.cligital Fgﬁificate i:_configurecl. (ljlsing a [ Other Distribution Options
digital certificate may improve security} . .
Select a Remotefpp program and choose an option
RDP Settings Change below,
@ Clients will not use any custerm RDP settings. & Create.rdp File
Create Windows Installer Package

'@' More about distribution options

RemoteAmems

Name oo L

| Path

| TS Web Acce.., | Arguments |

Ad|

|cﬁ¥edg@t__;&{m"

| | & % om
- Man hinh Wellcome—=> Next.

J Iﬁﬁ TS RemoteApp Mana...

WwE gl a13am

- Choose Program to add to RemoteApp Program list=>Chon cac tng dung cho Client—-> Next.

RemoteApp Wizard

Choose programs to add to the RemoteApp Programs list

Select the programs that you want to add to the RemoteApp Programs list. You
can also configure individual RemoteApp properties, such as the icon to display.

.’1

S
)

Mame

N

[ =]

O
0¢
[
HEY
L&
e
O,
0%
&
(] &

Ciigk. Defragmenter
iISCS| Intigtar
Memory Diagnostics Toaol
Paint
Problem Reports and Solutions
Remote Deskiop Connection
Security Configuration Wizard
Server Manager
System Configuration

System Information
1 Bz Windows Contacts.
] :'.'. Windows Updaté

T:'_J WordPad =

__'\_'._.\\\'1"
Seleczjfﬂgu_\'\;b Select Mone | Froperties... | Browse. .. |
S
A @J\ < Back Mea = Cancel |
‘u}
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- Review Setting—>Finish.

RemoteApp Wizard

Review Settings
Review the settings that you have chosen. You can go back to change these
gettings or click Finish to complete this wizard.

Lab # 16 — Terminal Services

!

~ &\@

}-;J’

Adding 1 program
Program list:
WordPad

RemoteApp program is available through 15 WWeb Access: Yes
Allow commanddine anguments: No

N\
R\

Path: %5YSTEMDRIVEX \Program Files"WindowsMT* Accessories wordpad .exe

-

vl

="

Cancel |

@Sg}\{ ) < Back I Finish I

- Trong man hinh TS remote App=>Cuon xudng cudi man hinh->Bam
application va chon Create Windows Installer Package.

phai chugt vao

Add Remotespp Programs

Show in TS Web Access

Hide in TS Web Access

RemoteApp Programs

Mame |

Create .rdp File
Oreste Whindows Installer Package

Remowe

Properties

EEXIEE 856 [

Help

Installer Package

ibutich cpticns

-

v | Arguments
Disabled

- Man hinh Welcome=> Next.
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- Bé mic dinh cac thong s6 ciu hinh->Next.
R
Specify Package Settings

You can specify the location to save the packages, and corfigure RemoteApp

connection and authentication settings.
N‘] i
N

Enter the location to save the packages:

C:"Program Files“Packaged Programs i Browse...
— Teminal server settings a\\\ﬁ;\
Server: WIN-45B0

Require server authentication:

Yes AL
Port: ElE.E'dii\-\;'\jﬁ“.'hl Change...
=

15 Gateway settings

7 Tl
©)
TS Gateway server settings ?i)7®1imlh.r detected.
/

/=N
r Cerfficate settings [‘..L:;l

Mo files will be si by a cerfficate.
N

Change...

)

a2 Al

‘ﬂ\ Change...
@?}“ < Back Cancel
- Chon Finish.
RemoteApp Wizard

X
Review Settings
Review the settings that vou have chosen. You can go back to change these

settings or click Finish to complete this wizard.
N
an®)
Adding 1 program ﬂ
(Generating output files in:

C::Program Files*Packaged Programs
- Creating RDF Files

Program list:

WordPad

Path: %SYSTEMDRIVE \Program FlesiMilindows NT Accessores wordpad .exe
Remotelpp program is available tingugh TS Web Access: Yes
Allow command-ine arguments \Na

TP, _|‘I
Ly@

< Back |§ Finish | Cancel |
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3. Chia sé folder chira file @ng dung:

- C:\Program File->Chudt phai 1én Packaged Program—>Properties—> Share Folder—>Everyone
Allow-Read>0K

I

== F % . ~
‘6 Qv I .~ Computer v Local Disk {C:) v Program Files + v m IS‘EL”"‘:"‘ ‘\@
s~
File Edit View Tools Help [ - 74
Organize v 135 Views v (=" Open 23 Share ( \C\ @
.
Favorite Links Name Ivl Date modified |v| Type | | Size dM
J. Common Files 10/23/2009 11:0... File Folder
[E| pocuments |, Internet Explorer 4, 11:2009 6:05 AM Flie Folder
E Pictures -
[;h Music | VMware Open Ider
; Windows Mail Explore der
[/ Recently Changed PR Kimicans o =
AN TNy ”
@ scnrchas L Windows NT zhare \ #de.
estore previous versi
J, Public ik 0\5\\ D
Send To \»

@O \/

. L } Properties

N >y

Fol ders A

4. Kiém tra trén may client:
- Start>Run->Nhap dia chi IP Remote Server
Vd: \\192.168.1.38 > OK.

).} o B
ame of a program, folder, d it, or
Internet resource, and 'n.'*.n'mdcl'n's will D]:I it for you,

#

L T

Wiy VaD l_ (514 ] [ Cancel l [ Browse...
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- Hop thoai yéu cau khai bao username/password diang nh
RemoteApp

ap> Nhap sv1/123>0K
?]x

Enter your credentials For WIN—'\?‘}SBOEES‘JDQK. These
credentials will be used when wou connect to the remote

camputer. \ o
Sy,
Iser narme! | S v|
=\
=11
Password: Y |

)
R
’ \
Y (o~ d [ (o]4 ] l Cancel l
I
- Chon tng dung can dung.
‘vl Date modified Ivl Type Ivl Size l'l Tags Ivl ~
10/23/2008 7:27... Windows Installe... 107KB Installer,...
10/23/2008 7:27... Remote Desktop... 2KB

- Chon Connect.

i The publisher of this remote connection cannot be identified.
Do you want to connect anyway?

This remote connection could harm your computer, Do not connect unless you know
where this connection came From or have used it before,

':h Publisher: Unknown publisher

Tvpe: RemaoteApp pragram
Rermoke computer: WIN-Y45BO62 300K

[ ]Don't ask me again for remate connections ko this computer

Zonnect ] I Cancel ] [ Details ==
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- Nhap vao user chung thuc>OK.

W

Enker wour credentials For WIN-'-.-'":SBQ@ES ¥, These

credentials will be used when vou connect bo the remote

comnmpuker, “‘\?\

o W
User name: |ﬁ.‘5@1] v|
f e J
Passwiord; ..) |-Ju-| |
v {}I [ Iremember my password
A/ ‘i
A&
Ay N

fa & ;«l L Ok J [ Cancel ]

\ B
- Qua trinh két néi dién ra va Ung dung can dung s& mé ra.

File Edit View Insert Format Help

Di2|E| SR ] o] B

lAriaI 3]10 HIWesiem 3 B|Z7|U|® E%l_;;_l '::_“\‘b
T P T W R R 5\3{\‘;%7
\ T \
\g‘)
&\Q\Q
\)
N
.*_,_\\\_\\\&/)
WD
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I11. Trién khai cac ing dung RemoteApp thong qua TS Web Access:
1. Cai dat TS Web Access trén Terminal Server:
- Server Manager—-> Terminal Services—>Add Role Services.

SLEl
File Acton View Help @ 67b)
€| 2m| Yo
i Server Manager (WIN-V45B06230C IS rae it b a e =3
= Roles == _11»)
%)% ’ \\)\
Add Role Services Provides technologies that enable access to a server runnin&ir}d&n‘s based programs or the
i Remove Role Services full Windows desktop. \ \
Tem yiew > i\& 7
Features "\ A\
ma =
Diagnostics Refresh jamary. Q\\\)
7 Configuratiol 5 =g - 7
4 Storagge Help . ; t;r:“fgrmatn:mal in the last 24, / / Go to Event Viewer
— ‘w\' 2 &} Filter Events
Y 1Events N )
\{. Properties
<« lfd\ 4 [ » = Hide All Events
Level vent ID | Date and 7]
Informat 1056  10/23/200f
R
/) / ‘\\
(N
21N |\
@
Np
. <« | »
N\ f\\‘,%
~\\\‘\\. - :
. )'\ »\o\\ ’--\\ (~ System Services: All Running 4 Go to Services
"\ et ) -
\~\{ ‘\\\ o/ Display Name | Service Nan Preferences
Q) \' 74 Terminal Services Termservice [l Stop
-,\a,\‘\,) \3 SR | | B s |
i) (D) 2 £ LastRefresh: 10/23/2009 8:31:37PM Configure refresh
5plas Help for the current selection. | [

- Chon TS Web Acess—=> Next.

Add Role Services

ﬂ Select Role Services

Role Services

Web Server (IIS)
Role Services

Confirmation

Progress

Results

Select the role services to install for Terminal Services
Role services:

|| Terminal Server (Installed)
[[] 75 Licensing
[] TS Session Broker

More about role services

< Previous " MNext > I

[] Ts Gateway ( G‘
\U)
aa\ & /
NN
N\
W/

& "‘ L%
)4(\/ :\",
))

/

f
\I

©

Access provides access to

D
s

'))erminal servers through a Web

Install Cancel
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- Chon Add Require Role Services.

T
(‘l - Add role services and features required for TS Web Access?
You cannot install TS Web Access unless the required role services and features are 2lso installed.
Bole Services: Descriptian
= Web Server (IIS) ek Servar{llS) provides a reliable,
Web Server " | manageable, and scalable \Web application
infrastructure.
Management Tools )
Bl Windows Process Activation Sgryics
Process Model %
MET Environment:
Configurstion AFe
Il \ Add Required Role Services Cancel
) | | |
ese role services and features required? 4

- Dé cac thong s6 mic dinh>Next->Chon Install.

Add Role Services B RN

3 . \\ \ “J
E Select Role Services )t
x &
Role Services Select the role services to install for Web Server (IIS): ‘ QO)
Web Server (IIS) Role services: ;
o We rver provides support for

'TML Web sites and optional support
‘or ASP.NET, ASP, and Web server

Role Services = [E Web Server
B [¥] Common HTTP Features

Confirmation
e Static Content / extensions. You can use the Web
°g Default Document (f \Y Server to host an internal or external
Results Directory Browsing ~“\\/) Web site or to provide an
(17/™ environment for developers to create

HTTP Errors
HTTP Redirection )

= [@ Application Developrﬁéﬂt \Y
V] ASPNET = \M/
vl NE(Equwsm\tv -
1 AQP \\ \™/J

Web-based applications.

E ISARI Extensxons
E TSAPI Filters
N \D Server Side Includes
< £ ) Bl @ Health and Diagnostics
V] HTTP Logging
[V] Logging Tools

ss Request Monitor
Tracing

[T custom Logging
j\\g 1 _APBr Lansina ;I
\ More about role services

‘ @Q < Previous I| u%§t> I Install Cancel
&
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Add Role Services

n Confirm Installation Selections

‘ @ This server might need to be restarted after thai

@ Termnal | Services

Ts Web Aocess
Default TS Web Access site: -V45806230QK ts

@ Web Server (115) \
@Fndwtmor W%s Resource Manager (WSRM) and how it can help

Web Server

%y Bfowsng
Errors

HTTP Redirection
Application Development
ASP.NET
.NET Extensibility
ISAPI Extensions
4PT Filters

Terminal Services

Web Servgr (11S8)
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Lab Windows Server 2008 Lab # 16 — Terminal Services
- Start->Programs—>Administrative Tools-> Terminal Service>TS RemoteApp Manager. Bam
chudt phai cac tng dung muon hién thi=>Chon Show in TS Web Access.

leix

File Action View Help - r:;) ]
= @ H Gy
FOVEFVIEW ﬂ Actions L

Distribution with TS Web Access

/4 The TS Web Access Computers group is empty.
RemoteApp programs may be unavailable to
users, Refresh | Learn more

Terminal Server Settings Change

155 hemoteapp M... «
LA \%b' L&
\

(@ Clients will connect to: WIN-V45B06230QK 1% comnectto Co...

" Users can only start listed Remotelpp programs
on initial connection. (Recommended)

TS Gateway Settings Change

I:D Clients will use TS Gateway settings defined by
their demain's Group Policy.

Digital Signature Settings Change

M No digital certificate is configured. (Using a
digital certificate may improve security.)

& AddRemotea..,
a
a
a

;-E Import Remot...

J Al RemoteApp programs are visiblein TS Web
Access,

® A remocte desktop connection for this server is
not visible in TS Web Aczess./Change

Terminal Serve...
TS5 Gateway 5...
Digital Signatu...

® More shout usi1g.TS Web Access Export Remot,..

Other Distribution Options

RDP Settings Change Select 2 Femotelpp program and choose an opticn View >
) . . lrelow,
@ Clients will not use any custermn RDP settings. ! B CC‘:'eate rdp File ﬂ Help
! Create Windows Installer Package WordPad =
S <AdE RemoteApp Programs bution opticns & Propertes
L) .
v Show in TS We...
= — Show in T5 Web Access @ o
emoteApp Programs > - -
P & Hidein TS Web Access @ HideinTs We...
Mame B | Arguments -
B Creste rdpFile
I'Wordpad |2 creste rdpFie
Bl cCreate Windo!
— [g] Create Windows Installer Package reats indo
\ M Remove
x Remave
11 u = E Help
W T e - £l Properties hd
(11 ANDNY [
.rdp File E Help | |

2. Kiém tra trén Terminal Client:
- M¢ Internet Explorer->Khung Address nhap vao dia chi Terminal Server
http:// 192.168.1.38/ts >Enter.
- Hop thoai khai bao username va password xuat hién. Nhap sv1/123.

Connect to 192.168.1.38

User name:

Passward:

[ Ok, l [ Cancel
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Lab # 16 — Terminal Services

- Sau khi dang

nhap thanh cong
/> TS Web Access - Windows Internet Explorer

- Lya chon cac tng dung can dung.

@@ = @] http://192.168. 1. 38/ts/en-US /Defauit. aspx
W ke (@ 75 Web Access

= Vi

RemoteApp Programs

Web Access

Remote Desktop

AL
(tz ©§)
o
W
QO
L

EI [E _lLive Search
a8 -

T T T [T [fa 7 rsses powed ideroF
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